
MACSQuant® Instrument short instructions

Start-up, shutdown and instrument monitoring

Instrument start-up

Switch on the instrument
1 Switch on the instrument to turn it into stand-bymode.
2 Touch the touchscreen to power up theMACSQuantify™ Software.
3 A login window will appear.

Login
1 Enter user name and password.
2 ClickLogin.

Note: After login, the instrument is in data analysismode. Data
acquisition is not yet possible. Prime the instrument before
proceeding.

Prime the instrument
1 To prime the instrument (power up the lasers, activate fluidics), click

on the Main instrument control button at the upper right of
the window and selectAcquisition mode.

2 Wait for the optical bench to warm up, which requiresat least 30
minutes.

Note: While the instrument warmsup, it is recommended to
perform a flush cycle followed bya clean program.

Lock the screen
The current user can lock the screen to prevent other users from
accessing the instrument.

Note: To deactivate the Lock function, refer to the Chapter The
Administrator in theMACSQuantify user manual.

1 Click on the user name at the upper right hand side of the screen.

2 From the drop-downmenu, select Lock screen.
3 To unlock, enter your password.

4 ClickUnlock.

Shutting the instrument down
Before switching off the instrument, shut down the system. Bydefault,
automatic shutdown after a certain idle time is enabled tomaximize
diode lifetime. Administrators can change the automatic shutdown
settingsunder Edit > Options (default) > Timers > Standby Timer.

1 To shut downmanually, click the Main instrument control
button at the upper right side.

2 Select Instrument off. After a seven-minute washing procedure,
the instrument is in stand-bymode.

3 Touch the touchscreen to start the instrument again. To shut down
completely, switch off themain switch at the lower right side of the
instrument.



The Instrument status bar

The current status (1) of the instrument is displayed in the Instrument
Status bar. The status indicator changes its color depending on the
current status. TheClear button (2) deletes the current data from the
plot. The statusof the current acquisition is shown in detail (3). At the far
right, theRinse button (4) and theStart button(5) are located. They
maybe inactive (grayed out) during certain processes.

l Right-click onRinse for the optionsClean or Flush. Refer to the
Instrument manual for details.

l Right-click onStart to access the optionsSkip (skip to the next
sample in line) or Pause.

The Instrument status indicator
Green The instrument is inAcquisition mode and

ready for measurement.

Yellow Cleaning and priming in progress. The instrument
is not available for measurement. If buffer or
waste bottle needs to be changed, the respective
information will appear in the statusbar.

Orange The instrument is inData analysis mode. Set
the instrument toAcquisition for measurement.

Grey The instrument is initializing and not available for
anymeasurement.

Blue The instrument is processing a sample.

Red Error alert.

Lasers and detectors
The lasers and detectors tab displays the statusof the optical bench. It is
possible tomonitor the statusof each laser fluorescence channel. The
temperature, fan speed, PMT voltage, and annotated path of each
laser is shown. A statusoverview of the optical bench is schematically
represented. The bench temperature is kept between 33 °C and 37 °C.
Therefore the fan speed is regulated automatically depending on the
ambient room temperature and internal temperature of the
MACSQuant® Instrument. Please note that the temperature for the
lasers should be between 10 °C and 45 °C. In case of errors, please
contact MiltenyiBiotecTechnicalSupport.

To access the hardwaremonitor, go toView > Hardware.

Figure 1: Example: Real-time Hardware
monitor of theMACSQuant 10 Analyzer optical
bench.

Are you in need of additional assistance?

Visitwww.miltenyibiotec.com/local to find your nearest Miltenyi
Biotec contact.
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MACSQuant® Instrument short instructions

Instrument settings

Before using the instrument for the first time, read the
MACSQuant Instrument user manual as well as the
MACSQuantify Software user manual.

Setup of detectors
1 If necessary, perform a PMT calibration (refer to theMACSQuant

Instrument short instructions PMT calibration for details).
2 In a new workspace, open a new analysiswindow, or a saved

analysis template and acquire some unstained cells.
3 In the Channels tab in the sidebar, adjust the voltage and scales for

the light scatter channels so that cells of interest are visible in the
FSCvSSC plot. If fluorescent channels require a different voltage
setting than default, use a fluorescently stained cell sample to
ensure populationsare positioned on scale.

4 To remove debris, or other populationsof cells not needed within
the dataset, select an appropriate Trigger channel and value.

Note: Details onmanual detector adjustment can be reviewed in
theMACSQuantify™ Software guide.

Automated multicolor compensation
Materials required

l Single-stained controls representing all fluorochromes to be used in
the experimental staining panel. Ensure that there is a comparable
positive and negative population for setting compensation.

l One unstained sample for use asblank sample and another
unstained sample for compensation against PI staining (optional).

l 12×75mm round bottom tubesor 96-well plate

l MACSMiniSampler Pluswith either Chill 5 or Chill 96 Rack

Protocol

1 Ensure that the Instrument is calibrated and that all PMT voltages
for the cell sample are adjusted.

2 Prepare single-stained controls for all fluorescent reagents used in
the experimental staining panel. Cells or compensation beads can
be used as controls.

Note: It is recommended to have one tube that is a true blank for
the compensation controls.

3 Select an appropriate Chill rack from the drop-down list in the
Experiment tab. Typically, the Chill 5 or the Chill 96 rack is used.

4 Click on the Rack button (1) in the toolbar, if theRack dialog
box doesnot automatically appear.

5 In theRacks dialog box, the respective rackwill be displayed.
Select the appropriate number of sample positions tomatch the
number of samples that will be used for compensation. Note the
rackprocessing order (horizontal or vertical, see symbol in the
upper left corner) and place your samples in the rackaccordingly.

6 Click on theGroup button at the bottom of the window. Each of the
selected rackpositions should now be labeled with the number 1.

7 Go to theExperiment tab. Click on theSettings tab and activate
theExpress option button.

8 From the Type drop-down list, selectSetup. From theMode
drop-down list, selectCompensationMultiColor .

9 Select an individual circle in the rackwindow (only one at a time). In
theSample ID field, a drop-down list will become available. Select
the respective fluorochrome.

10 Each fluorochrome that appears in the drop-down list represents a
specific detection channel (e.g. PerCP-Vio770 represents channel
B3). If using another B3–compatible fluorochrome, e.g., PE-Cy5,
PerCP-Vio770must be selected.



11 SelectBlank for a sample of unstained cells. This is the reference
for negative cellsand should alwaysbe included.

12 Select PI if propidium iodide is used for dead cell exclusion in later
experiments. It is used for correcting all fluoresecence spillover from
the B3 channel. Addition of PI to this tube is not necessary.

Note: For compensation, use an unstained sample that matches
other compensation controls and do not add PI.

13 Place samples in proper rackpositionsand start the acquisition.
Follow the onscreen instructions.

Manual compensation using the 8×8 com-
pensation matrix
Materials required

l Single-stained controls representing all fluorochromesused in the
experimental staining panel. Ensure that there is a comparable
positive and negative population for setting compensation. Each
samplemust contain a negative and a positive population.

l 12×75mm round bottom tubesor 1.5mL tubes

l Single tube rack

Protocol

1 Ensure theMACSQuant Instrument is calibrated, and that all PMT
voltages for the cell sample are adjusted.

2 Choose an analysis template (e.g., four dot plots) by clicking on the
New analysis window button (1) in the toolbar.

3 Change one dot plot into a histogram and display the respective
channel of the stained particles (e.g., use B1for FITC).

4 In theExperiment tab, set all necessary parameters, e.g.Sample
ID andUptake volume.

5 Open the compensationmatrix by clicking the Instrument settings
button in the toolbar or under Edit > Instrument settings and
selecting theCompensation tab.

6 Click the Start Measurement button (2).

7 When events start to appear on the plots, pause themeasurement:
Right-click on theStop button in the instrument statusbar and
click the Pause button (3).

8 Draw a scatter region around the population of interest within the
FSC versusSSC dot plot. Thiswill be P1.

9 Displayevents in P1 region in the fluorescence histogram plot by
selecting the P1 region from the drop-downmenu of the plot
header.

10 Draw interval regionson the negative and positive populations.

11 Display themedians for all spillover channels used in the experiment
by clicking on the i button, selecting the spillover channels (e.g. B2,
B3, etc) , andMedian from the Feature Function tab.

12 Click on the Pause button (3) to resumemeasurement.

13 Click theMatrix checkbox.
14 Place the first single-stained tube (e.g., FITC-stained cells) into the

single tube holder.
15 To add compensation to the combination of channels in the plot,

choose the appropriate cell in thematrix. The columns represent
themeasured fluorochrome, the rows represent the detection
channels, where the spillover fluorescence should be corrected.
E.g., to compensate a FITC-stained sample against the PE
channel, go to the cell FITC/B2 and adjust the value to achieve
equivalent median fluorescence intensities values.

16 Adjust values for other spillover channels, if necessary.
17 Once compensation is adjusted for this fluorochrome, repeat

compensation for all additional fluorochromes.
18 When finished, save asan Instrument settings file.
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MACSQuant® Instrument short instructions

Setting up an acquisition

Setting up an experiment
on the MACSQuant® Instrument
Before using the instrument for the first time, read the
MACSQuant Instrument user manual as well as the
MACSQuantify Software user manual.

TheMACSQuantify™ Software provides the user a simple interface to
program various sample parameters for data acquisition. Follow this
quick guide to see how to easily set up a basic experiment for acquisition
in the single tube format.

Figure 1: TheExperiment tab.

General experiment settings
1 Go to theExperiment tab.
2 From theRack drop-down list, selectSingle tube rack. If the

box to the right of the field is activated, the instrument will
automatically detect the used rack. Available rack typesdiffer
between instrument types. .

3 (Optional) Change the file name: deactivate the File checkbox to the
right of the file name and enter a unique file name.

4 Enter alphanumeric text for theSample ID andDescription if
desired.

Flow rate

Keep events/second rate below 10,000 for accuratemeasurements.
1000 - 5000 events/second is ideal. The flow rate can be adjusted by
doing one of the following: 

l Select Low for high cell densities (~107),Medium, or High for very
low cell densities (~106).

l Check the box to the right to switch to events/s. The flow rate is
automatically adjusted to approximate the selected value.

Flow rate
(µL/min)

Sheath buffer consumption
(µL / measurement)

Total time
(s)

Low: 25 18,000 240

Med: 50 13,000 120

High: 100 8,600 60

Table 1: Flow rate and sheath buffer consumption for a 100 μL sample, run in
standardmode.

Pickup and measure

1 From the drop-downmenuMix sample, select amixing option if it is
desired to premix the sample before sample pickup, data acquisition
and analysis. Availablemixing optionsdiffer between the instrument
types.

2 Select amode from theMode drop-down list (Screen, Fast,
Standard, Extended, Enrich, EnrichS, EnrichS2).

Note: Enrich programsare only available onMACSQuant 10 or
VYB instruments. Screen is only applicable if using a chill rack.

3 Enter anUptake volume and aSample volume. Themaximum
uptake volume and sample volume for theMACSQuant 10/VYB is
450 µL and 5mL, respectively. Themaximum uptake volume and
sample volume for theMACSQuant X is 5mL.

Note: If mixing is selected, it is necessary to accurately define the
sample volume to avoid the uptake of air bubbles.



Settings

1 Go to theExperiment tab and select theSettings tab.
2 Activate the radio button next toCustom.

3 For Custommode analysis, select the checkboxesnext to
Instrument settings,Analysis template, Live gate, and
Events options to activate these features.When deselected, the
instrument will run with the current active Instrument settings.

l Instrument setting: select the adjacent checkbox to load and
apply previously saved instrument calibration and compensation
settings.

l Analysis template: select the adjacent checkbox to load and
apply previously saved cell analysis templates.

l Gate: select the adjacent checkbox to activate gate settings.
Stop gate: measurement will end and datafile will be saved
once event limit is reached in the chosen gate. Live gate: only
eventswithin the gate will be saved in the datafile.

l Events:select the adjacent box to stop data acquisition and
save datafile after a defined number of total events is obtained;
in this example, 10,000 events.

Plot properties

Figure 2: Features of aMACSQuantify™plot. Tomodify its appearance, click
on the 'i' button to the right of the plot.

Open an analysis window

Analysis templates consist of a plot template and, if required, a gating
strategy. Analysis templates can be created post-acquisition or during
acquisition in Livemode. The next stepsare NOT necessary if a pre-
defined analysis template is already selected within theSettings tab,
or opened within the workspace.

1 Click the New analysis window button (1) in the toolbar or
go toWindow > New analysis window.

2 Select the desired analysis template from the plot options. Multiple
analysiswindowscan be opened, each can be comprised of single
or multiple experiments.

3 If multiple analysiswindowsare open, use the previous and
next analysis window buttons (2) in the toolbar to access
hidden windows.

Draw a gate

1 To create a gate or region, click on one of the tool buttons (1)
from the toolbar or choose the tool from theEditmenu.

2 If using ellipse, rectangle, quadrant or interval, left-click on a plot and
start dragging a gate. Release the left button to finish drawing.

3 If drawing a polygon, left-click once to start drawing the first point.
Move the cursor and left-click again to draw the next point. Continue
asdesired. Double-click to draw the last point and finish the gate.

4 When the gate is selected, the edit points can then be used to adjust
the size and shape.

5 Click and drag the gate tomove it to a new position.

Annotation

1 Select theAnnotations tab.
2 Modify the annotations for the fluorescence channels, if required.

Note: Annotationsmaynot appear on the plot displaywindow
until acquisition starts.

Are you in need of additional assistance?

Visitwww.miltenyibiotec.com/local to find your nearest Miltenyi
Biotec contact.
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MACSQuant® Instrument short instructions

Autolabeling and multisampling

Description
Before using the instrument for the first time, read the
MACSQuant Instrument user manual as well as the
MACSQuantify Software user manual.

If running amultisample experiment, use theMACSMiniSampler Plus
in combination with one of the Chill Racks. Five different kindsof sample
tube racksare available, allowing for processing up to 96 (MACSQuant
10 or VYB) or 384 (MACSQuant X) samples in a single batch. Several
different typesof cell samplesor analysis panels can be configured on
the same rack. Samples can be automatically labeled with fluochrome-
conjugated antibodies, cocktails, or fluorescent dyesprior to
measurement. Use theMACSReagent Rack4 for labeling several
sampleswith up to four different reagents. TheMACSMiniSampler can
be configured to perform autolabeling andmeasurements from any
sample position. MiltenyiBiotec reagents can be entered automatically
using the 2D code reader.

Commonly used Chill Racks

Chill 5 Rack Chill 96 Rack

Slots 24 × 5mL 96-wellmicrotiter
plate

Corresponding
MACSQuantify
Rackwindow

Table 1: CommonChill Racks used for multisample processing on the
MACSQuant Instrument.

Chose a rack

1 Go to theExperiment tab.
2 Select the required rack type from theRack drop-down list, or

click on the Rack button (1) in the toolbar open the Racks
window.

3 The corresponding rack template is displayed in the lower section of
theExperiment tab windowand in a window in themiddle of the
screen.

Sample rack configuration
1 Click on the sample position(s) using the left mouse button or touch

screen. An entire row, column, or table can be selected. To select
multiple samples, right-click on:

l the upper left circle for the entire rack

l a column number to select the entire column

l a row letter to select the entire row

2 To program sample positions, ensure that all positions to be
programmed bya given strategyare activated ( / ). All samples
can be programmed at the same time, or each position or group of
positions can be programmed individually.

3 Use theExperiment tab to specify theExperiment, Flow rate,
andPickup and measure options. Verify proper annotationsas
well as autolabeling reagents and designations.

4 Left-click or touch screen to switch between / and / .

5 Ensure all sample positionshave the correct associated
programming. To view the experiment settings for all sample
positions, clickView > Experiment table.

6 Refer to table 2 for an overview of rack configuration, and to the
user manual for more information.
Use the Experiment tab to change parameters of the experiment
(flow rate, uptake volumes, etc.) andCustom (instrument settings,
analysis templates) or Express (MC Cocktail analysis templates )
settings.

7 Refer to theMACSQuant Instrument Short instructionsSetting up
an experiment, or to the user manual for more information.



Sample rack positions

Sample rack color scheme

Clear Default open circle indicatesno
operation.

Closed green
circle (grey for
the colorblind
format)

Sample selected for
measurement. Left-click on circle
to select.

Closed green
circle with
orange rim (grey
with orange rim
for the
colorblind
format)

Sample selected and activated for
editing. Single click on circle to
activate. The orange circle
indicates that the sample is
activated for editing.

Closed yellow
circle

Processing of sample has
commenced, e.g., sample has
been labeled and incubation is
underway.

Closed blue
circle

Measurement in progress.

Closed gray
circle (green for
the colorblind
format)

Measurement finished.

Table 2: Sample rack configurations (default setting and adjusted for
colorblind users).

Autolabeling
1 If autolabeling is required, add the relevant reagents by clicking on

an <add…> checkbox. Alternatively, go toEdit > Reagents to
open theReagentswindow.

2 Select the reagentand reagent rackposition from thedrop-down list.

Note: Propidium iodide (PI) is listed under Universal.

3 To dilute samplesautomatically prior to measurement, select a
buffer dilution from S1 or S2.

4 Checkand adjust the incubation time, titer, and order asneeded.
Note that MACSMC cocktails and fluorochrome-conjugated

antibodieshave predefined time and titer. Order is used if several
reagentswith different incubation timesare added to one sample
(e.g. antibodyand PI).

5 A total of four reagents plus buffer A, B and C can be loaded. Once
complete, clickApply to confirm.

6 In theAutolabel tab, see the uploaded reagents available to apply
to the rackpositions.

Configure rack positions for autolabeling
1 With the designated rackopen, select and activate wells for

autolabeling ( / ).

2 Repeat for other samplesand reagents if required.

Note: If usingMC Cocktails for autolabeling, a predefined
analysis template can also be assigned to the wells using Express
mode under theSettings tab.

Review experiment settings
Before starting the run check that:

l Experiment definitionsare correctly assigned to each rack
coordinate and that each sample is correctly positioned on the Chill
Rack.

l Sufficient quantities of reagents and buffers are provided. Ensure
that the waste bottle is empty.

l The reagents have been imported and assigned to a position on the
MACSReagent Rack4.

l The instrument is correctly calibrated and compensated.

All experiment settings can be reviewed in an experiment table.

1 Go toView > Experiment table.
2 Switch betweenAcquisition,Annotations,Autolabel or

Settings to review the respective settings.

Are you in need of additional assistance?

Visitwww.miltenyibiotec.com/local to find your nearest Miltenyi
Biotec contact.
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MACSQuant® Instrument short instructions

File management

Description
Before using the instrument for the first time, read the
MACSQuant Instrument user manual as well as the
MACSQuantify Software user manual.

In addition to automatically saving data files, theMACSQuantify™
Software enablesusers to create and save variousother files for
efficient use of theMACSQuant® Instrument. These files include
analysis templatesand instrument settings. This quick guide providesa
brief description of these file types, and guides the user through how to
transfer files from the instrument for further use on personal computers.

File types

Analysis templates

An analysis template is a pre-defined layout for acquired data and is
composed of plots, statistics or tables, gating strategies, and defined plot
and region properties, such as region namesand displayed statistics.
Analysis templatesare data-independent and when opened will not
contain anydata, but can be used to insert data for analysis. Analysis
templatesare saved in the Analyses folder in either Public or Private
locations, asdesignated by the user.

Figure 1: Example of an analysis template. Associated hierarchical gating
strategy is shown for clarity.

Experiments

Experiments can be defined for repeated use if you typically run routine
assaysor similar sample sets. Files comprise all selectionsdefined for a
particular sample or set of samples in theExperiment tab. Experiment
settingsare saved in either the Private or Public location, as selected by
the user, in the folder calledExperiments.

Instrument settings

Instrument setting files consists of PMT voltage values, channel scales,
compensationmatrix, height, width, and trigger selection that are
important for data acquisition of specific experiments. Instrument
settings can be loaded the next time an experiment is performed, but
should not be used long term. Default instrument settings saved during
calibration, aswell as bank settings, are saved in the Public location in
the folder called device. Manuallymodified instrument settingsare
saved in either thePrivate or Public location, as selected by the user,
in the folder called device.

Store the entire experiment setup in a Workspace file

AWorkspace file is all encompassing, and represents amaster file
including information for the other file types. It contains the following
information:

l Sample tab: samples currently displayed in the sample list

l Experiment tab: All experiment parameters

l Instrument settings: Current instrument settings including
compensation and calibration

l Analysis template: current analysis view and template, if selected

Workspacesaremost useful on a PC, due to the fact that instrument
settingsand sample listswill change from day to dayon theMACSQuant
Instrument.Workspaces can be stored in thePrivate or External
location but not in thePublic location.Workspaces are saved in the
Private or External location in the prj folder.



Data management
It is recommended to backup data to a remote location and to remove
from theMACSQuant Instrument regularly. Save copiesof your data to
either USB thumb drives, external hard drives, network locations, local
PCs, etc. Use either theBackup or theCopy function. Both functions
do not automatically delete files from the instrument.

Data back up to remote storage location

1 To backup data files, click on the Backup button from the
toolbar.

2 If requested, enter password when prompted.
3 Select all files or all data fileswhen prompted.
4 All previously backed up .mqd fileswill be deleted, if you selected

delete cloned files. However, all .fcs files need to be deleted
manually.

5 When the backup is complete, a dialog box confirmation appears.

Note: If a Private backup option hasbeen defined, it will also
appear asa source or destination in the Copydialog.

Copy files

An administrator can copyall files, including (private) files of all users, all
files in Public locations, and administrator files in a Private location. By
using the folder All user in the Copydialog box, the administrator can
clear up the hard drive after copying the files to a remote storage
location (e.g. network folder, USB stick, hard drive). Custommode
users can only copy their own files (Private folder) and files in the Public
folder (depending on their access rights).

1 To copy files from theMACSQuant Instrument to a remote storage
location, select File > Copy....

Note: To transfer data from theMACSQuant Instrument to a
USB stick, insert it into an USBport of the instrument.Wait for the
device to be recognized.

2 Choose the destination from the available drop-downmenu in the
dialog box. If you are transferring data to a network location, enter
the password when prompted.

3 From the drop-down list, select:

l To: the selected files are copied to the selected destination. The
source folder structure is also preserved at the destination
location.

l From: selected fileswill be imported. The filesmust be
organized in the same folder structure as in the destination
folder to be propery importet.

4 Check the boxnext to the desired files or folders.
5 ClickCopy. When all files are copied, a report dialog boxappears.
6 Close the box to execute another copyor deletion command.
7 When using a USB stick, clickeject and close to safely remove the

USB stick. Alternatively, you can selectRemove external media
from the tools tab.

Are you in need of additional assistance?

Visitwww.miltenyibiotec.com/local to find your nearest Miltenyi
Biotec contact.
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